


PUBLIC COMMENT, OGIS ANNUAL OPEN  MEETING MAY 12, 2021 
 
 

(Also submitted to FOIA ADVISORY COMMITTEE 
& CHIEF FOIA OFFICERS COUNCIL) 

 
RECOMMENDED SYSTEM CHANGE REQUESTS to FOIAonline 

Including Simple Solution for “Release to One, Release to All” 
 
 

I. BACKGROIUND. RECOMMENDED SYSTEMS CHANGES TO FOIAonline. 
 
Please post this Public Comment, add it to the May 12, 2021 OGIS Annual Open Meeting 
Agenda and address it as a topic during the meeting the following comments, which are related 
to “REPORT TO THE ARCHIVIST OF THE UNITED STATES, Freedom of Information Act 
Federal Advisory Committee 2018-2020 Committee Term Final Report and Recommendations 
July 9, 2020.” Perhaps EPA’s Brian K. Thompson, in coordination with the FOIAonline Change 
Control Board, can provide a briefing/briefer. I have provided these recommendations to Mt. 
Thompson and the FOIAonline Change Control Board. I believe that 20 minutes should be 
devoted to this topic. 
 
FOIAonline is the “gold standard” for federal FOIA portals/case management systems, in 
my view.  
 
I recommend that Agencies consider this application, in lieu of pursuing costly development of 
independent platforms at government expense as DOJ has recently done. DOJ is developing 
FOIA Star, which has rudimentary, primitive capability compared to FOIAonline and, and DOJ 
did not notify Requesters of its transition from FOIAonline to FOIA Star, nor properly transition 
existing cases from FOIAonline. At a minimum, any Functional Requirements Document should 
address the capability of FOIAonline and costs, which should be included in any approvals, 
including Milestone Decisions for any new applications. 
 
“Release to One, Release to All” Solved. 
Recommended systems change to allow “release to one, release to all” by allowing the FOIA 
requester to embargo from public review and then un-embargo FOIA requests, released 
documents and case processing records while precluding Agencies from shielding records from 
public view. MUCKROCK.com, which is a non-profit FOIA portal used widely by members of 
the media and private requesters already has this simple functionality. MuckRock also has the 
capability for automatic follow-ups on aged FOIA requests and appeal and preserves that data. 
 
This post relates to Recommendation #12: “We recommend that agencies release FOIA 
documents to the public on their FOIA websites and in FOIA portals in open, legible, machine-
readable and machine actionable formats, to the extent feasible.” 
 
I. Recommendation to Congress. I suggest that this recommendation also be made to 

Congress to mandate that Agencies provide open, searchable access to their FOIA portals 



without blocking public view of requester names, request details, correspondence, and 
release of records. The requester should be able to control, “release to one, release to all” as 
is the case for the non-profit MUCKROCK.com FOIA portal (which allows the Requester to 
“embargo” a request from public view for a period at the Requester’s discretion (to protect a 
journalist’s scoop for example) but does not permit the Agency to block public view)). See 
amplification regarding needed systems changes to FOIAonline.gov herein, which have been 
sent to the Environmental Protection Agency (EPA) Program Management Office for 
FOIAonline. 
 
 
II. RECOMMENDED SYSTEMS CHANGES TO FOIAonline  

 
The following recommended system change requests for FOIAonline.gov have been 
submitted to EPA through the FOIAonline.gov helpdesk and to the FOIAonline Change 
Control Board. 
 
Subject: EPA Priority System Change Requests Needed – FOIAonline.gov,  
 
Background.  
The goal of FOIA is the PUBLIC RELEASE OF RECORDS. The names of the FOIA requesters 
as courts have held that under the FOIA requesters do not have an expectation of privacy, as 
sited by DOD: Stauss v. IRS, 516 F. Supp. 1218, 1223 (D.D.C. 1981). FOIAonline must serve 
as a platform for public release of records. Other platforms, such as MUCKROCK.com allow a 
requester to embargo a request from public view for a certain period as a means for media to 
protect their information prior to publishing stories. However, in FOIAonline the “Description 
Available to the Public flag is set to “No” on default. Set this flag to “Yes” in order to make the 
description publicly searchable and viewable.” Agencies do not change the flag even for years old 
completed requests, defeating the purpose of FOIA. The Agency should not have any ability to control 
the “Description Available to the Public” or the Requester Identity or to alter the “Request 
Description” for requests submitted though the FOIAonline.gov portal. These decisions should be 
entirely up to the Requester. All records associated with the Agency’s receipt of, action taken, 
exemptions claimed, and records released should be publicly available. Failure to do so also impedes 
accountability wherein anyone should be able to match the dates received and completed along 
with the Agency’s Raw Data supporting its annual FOIA report to document those cases of clear 
inaccurate Annual FOIA reporting to the Attorney General of the United States. (False FOIA 
reporting withing the DOD is massive, widely known, and ongoing.) 
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Enumerated FOIAonline Changes 
 

1. “Description Available to the Public” Must be the Requester’s Choice, not the Agency’s 
Choice. “Release to one, Release to All” Solution. 
  
Deficiency. FOIAonline must serve as a platform for public disclosure of requests and records. In 
FOIAonline the “Description Available to the Public flag is set to “No” on default. Set this flag to 
“Yes” in order to make the description publicly searchable and viewable.” Agencies do not change the 
flag from “No” to “Yes,” even for completed requests, defeating the purpose of FOIA. The Agency 
should not have any ability to control the “Description Available to the Public” or the Requester 
Identity. These decisions should be entirely up to the Requester. Ostensibly, the Agencies have claimed 
that they need this ability to protect personably identifiable information, but that is false. All 
information entered a FOIA request originated in the public domain. Agencies are using this procedure 
to redact the identities and contact information of government officials who in nearly all cases have 
placed the information into the public domain themselves or it is posted on public web sites. This 
includes FOIA officials and points of contact identified in Agency determination letters and 
appellate determinations (as required by statute) and emails sent to the requester himself, which 
agencies want to improperly redact. If a request number is entered into the FOIAonline.gov search 
and the “Description Available to the Public flag is set to “No,” FOIAOnline.gov will display “Under 
Agency Review.”   
 
Required Systems Change.  

a. Remove the Agency’s ability to set the Description Available to the Public” flag. 
b. In the online request submission process allow the requester to select whether he/she wants 

his/her request to be publicly available or embargoed from public view. 
c. Allow the requester to later un-embargo a request to make it publicly available. 
d. In the alternative, remove the ability to set the flag to “no and allow all FOIA requests and 

appeals to be publicly searchable and viewable. 
 
2. “Requester Name” Must be the Requester’s Choice, not the Agency’s Choice. 

 
Deficiency. The decision as to whether a requester’s name is publicly available must be made by 
the requester and not the Agency. This allows other requesters to follow the work of a requester 
and potentially collaborate on certain topics, such as public malfeasance in FOIA processing. 
Other platforms such as MUCKROCK offer this capability. For example, requester Robert 
Hammond submitted 173 requests via FOIAonline.gov to Department of Navy. A public search for 
“Hammond and Department of Navy” returns two results (DON-NAVY-2018-012025 and DON-
NAVY-2018-012024), but  even there the request details are shown as “under review” and no 
records are accessible from FOIAonline.gov public view. This also impedes accountability 
wherein anyone should be able to match the dates received and completed along with the Agency’s 
Raw Data supporting its annual FOIA report to document those cases of clear inaccurate Annual 
FOIA reporting to the Attorney General of the United States. (False FOIA reporting withing the 
DOD is massive, widely known, and ongoing, based on my comparisons of my records 
FOIAonline data and data within other FOIA portals to Annual FOIA Report “raw statistical data.” 
Moreover, in apparent violation of law, DOD has not posted its FY 2016 raw data and data for FY 
2017 lacks individualized FOIA case/tracking numbers for certain agencies (such as Defense 
Health Agency) mandated by statute and needed for FOIA tracking.) 

https://www.foiaonline.gov/foiaonline/action/public/submissionDetails?trackingNumber=DON-NAVY-2018-012025&type=Appeal
https://www.foiaonline.gov/foiaonline/action/public/submissionDetails?trackingNumber=DON-NAVY-2018-012024&type=Appeal
https://www.foiaonline.gov/foiaonline/action/public/submissionDetails?trackingNumber=DON-NAVY-2018-012024&type=Appeal


 
Required Systems Change.  
  

a. Remove the ability for the Agency to block the identity of the requester. 
b. In the online request submission process allow the requester to select whether he/she wants 

his/her name to be publicly available or embargoed from public view. 
c. Allow the requester to enter a “screen name’ for public view in lieu of requester name. 
d. Allow the requester to later un-embargo his/her name on a request to make it publicly 

available. 
  
Background There are serious deficiencies within the FOIAonline.gov web application that 
allow agencies to cheat the process and impede transparency. All my FOIA requests contain an 
email address and nearly all are submitted via the FOIAonline application. While I refer to the 
Request Details tab and the Correspondence tab, these are simply the visible displays in 
FOIAonline.gov. My System Change Requests below would apply to the underlying program 
code and database. 
 

3. Requester Inability to Reply in “Correspondence” Tab 
 
Deficiency. Where there is only a “system” response to a request (such as initial 
acknowledgement of request or appeal receipt) and no agency correspondence in the 
“correspondence tab” the requester is unable to initiate follow-ups for requests or appeals that 
may be several years old. Even offline follow-ups via email directly to the agency are not then 
recorded by the Agencies in the correspondence tab. This applies to requests submitted both 
through the application and those entered by the Agency. This is an extremely serious void that 
ultimately impacts public disclosure and FOIA litigation. All case file data should be preserved 
within the application. See examples: 

DON-NAVY-2018-001229 Request Simple 11/09/2017 N/A Assignment 
DON-NAVY-2019-000954 Appeal N/A 11/01/2018 12/03/2018 Assignment 

 
Required Systems Change. Allow the Requester to reply to system generated notices without 
having to wait for the Agency to initiate correspondence which may never come. While the 
Requester can “Modify this Request,” follow-ups are not modifications and placing any 
correspondence in the “Request Details” tab would allow the Agency to treat a follow-up as a 
modification and restart the processing time clock for FOIA reporting. 
 

4. Agency Improperly Placing Correspondence in the Request Details tab. 
 
Deficiency. While the Agency can enter data and documents in the Request Details tab for 
requests that are not submitted through the FOIAonline.gov application, I have examples where 
the Agency has entered final determination letters in the Request Details tab rather than the 
Correspondence tab and never sent the final determination letter. This appears to be an 
intentional act, which impacts FOIA appeal rights and litigation.  
 
Required Systems Change. In instances where the Requester has submitted a FOIA request via 
FOIAonline.gov, the Agency should not have any ability to enter any correspondence 
whatsoever in the Request Details tab. Similarly, once a request is created for an offline 



submission, the Agency should not have any ability to enter further data or correspondence in the 
Request Details tab. 
 

5.  Agency not Placing all Correspondence in FOIAonline.gov and not making 
Correspondence viewable to the Public. 

 
Deficiency. All correspondence between the Requester and the Agency must be placed into the 
correspondence tab and it must be Publicly viewable by anyone. All case file data should be 
preserved within the application, which also impacts ongoing work to implement automated 
record retention in FOIA portals/case management systems. Additionally, DOD has improperly 
combined multiple FOIA requests into a single determination letter and failed to post the 
determination letter in all FOIA Requests/Appeals within the application. This also defeats any 
efforts to apply records management to FOIA records within the application.  
 
Required Systems Change. Require that all correspondence between the Requester and the 
Agency be placed into the correspondence tab and make all correspondence Publicly viewable 
by anyone. 

 
6. Agencies Improperly “Modifying” Requests and Appeals. 

 
Deficiency. FOIAonline.gov allows the Agency to modify the description of a FOIA request or 
appeal and to only display in the Public view the Agency’s modified “Request Description.” 
Ostensibly, the Agencies have claimed that they need this ability to protect personably identifiable 
information, but that is false. All information entered in a FOIA request originated in the public 
domain. Agencies are using this procedure to redact the identities and contact information of 
government officials who in nearly all cases have placed the information into the public domain 
themselves or it is posted on public web sites. This includes FOIA officials and points of contact 
identified in Agency determination letters and appellate determinations (as required by statute) and 
emails sent to the requester himself. There is no statutory authority for an agency to modify a FOIA 
request or appeal and doing so is a violation of the FOIA. 
 
Required Systems Change. Remove the ability for an agency to modify a FOIA request. It is a 
violation of the FOIA for the Agency to do so. 
 

7. DOJ Discontinued Using FOIAonline Without any Notice to Requesters or 
Transition of Records to “FOIA Star.” 

 
Deficiency. After submitting an Administrative appeal for a DOJ FOIA request, I learned that 
DOJ had implemented its own FOIA portal/case management system, FOIA Star without any 
notice to FOIA requesters nor any transition of all case management data to the new application. 
It is unclear what the justification for developing a new application is, but FOIA Star is a very 
primitive application that lacks the functionality of FOIAonline. As a taxpayer and frequent 
FOIA requester, this concerns me greatly. 
 
Required Systems Change. Suspend any action to remove or make unavailable to the 
Requester/Public all DOJ FOIA requests and appeals until DOJ advisors all requesters of its 
transition to FOIA Star, implements a process to seamlessly transition all requests and appeals 



currently in FOIAonline and to preserve such data in a manner accessible to the re quester that is 
similar to FOIAonline and implements a robust correspondence processing capability. I believe 
that no changes should be made until DOJ publicly briefs its FOIA Star Application and seeks 
user comments from the current DOJ Request users of FOIAonline. Any costs of transitioning 
records should be born solely by DOJ as a part of its system development/sustainment costs. 

 
 

III. CHIEF FOIA OFFICERS COUNCIL (CFOC) TECHNOLOGY COMMITTEE 
FOIAONLINE WORKING GROUP. OPEN AGENCY FOIA PORTAL 
REQUEST/APPEAL RECORDS TO THE PUBLIC 

 
This relates to the Chief FOIA Officers Council (CFOC) Technology Committee 
FOIAonline Working Group (“Working Group”) as discussed below. Please contact me.  
 

1. I am seeking an opportunity to participate in the Working Group meetings to provide 
much needed FOIA Requester perspective and recommendations to improve FOIAonline. 
I am a frequent user of FOIAonline and have much to offer. 

2. I am seeking a presentation from the FOIAonline Working Group at the next Advisory 
Committee meeting that addresses my recommended FOIAonline Systems Change 
Requests. I would like an opportunity to participate in the discussion and am prepared to 
provide PowerPoint slides.  

A. CHIEF FOIA OFFICERS COUNCIL (CFOC) TECHNOLOGY COMMITTEE 
FOIAONLINE WORKING GROUP CHARTER 

Lasted Updated: January 24, 2021 

Co-Chairs:     Mark Muro 
                        Ryan McQuighan 
                        Ryan Landrum 
                        Matthew Pollack 
                        Cindy Cafaro 

Objective: The FOIAonline working group will analyze and review the capabilities of 
FOIAonline which provides services to over twenty government agencies. This group will work 
to create a community of interest to leverage diverse user experiences to highlight best practices, 
compile frequently asked questions and answers, user guides, and make recommendations to 
improve FOIAonline capabilities supporting FOIA processing throughout federal agencies using 
this tool. 

Proposed Deliverables and Target Deadlines: 

1. Compile and make available Frequently Asked Questions (FAQs) beyond those already 
published on the FOIAonline site and make recommendations to the government solution 
FOIAonline to expand the FAQs already in existence to reflect working group input. 
Develop a brief “Top 10” FOIAonline paper related to the implementation and utilization 
of FOIAonline. - Target Deadline: February 28, 2021 



 
This is a research deliverable. Actions to be taken include the following: review existing 
FOIAonline documents and reports, discussion with FOIA professionals who are open to 
sharing their experiences with FOIAonline and other research approaches. 
  

2. Building off the work product above, host an event for FOIA professionals who have 
used or are currently using FOIAonline to discuss best practices and challenges on any of 
the topics covered in #1 above. - Target Deadline: March 2021 (specific date TBD) 
  

3. Participate in the Vendor Day held by the Technology Committee/Office of Information 
Policy (OIP)/Office of Government Information Services (OGIS). 

 
Respectfully submitted, 
 
Robert Hammond 
Attachment: FOIAonline Agency User Guide 
 

https://www.archives.gov/ogis/about-ogis/chief-foia-officers-council/technology-committee
https://www.justice.gov/oip
https://www.justice.gov/oip
https://www.archives.gov/ogis
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1 Submitting a Request 
The public has the ability to submit FOIA requests in the system, but requesters may choose to bypass the 
system and submit requests to your office either via mail, fax, or email. As an agency user, you can manually 
enter the request into FOIAonline to make it available for tracking and reporting purposes. 
Have a frequent requester who continues to submit requests outside of the system? Pre-populate a frequent 
requester’s contact information by locating a previously submitted request and duplicate their contact 
information on a new Create Request form (1.2). 

1.1 New Requester Steps 
The following steps are required of an agency user for requests submitted outside of FOIAonline from a new or 
infrequent requester: 
 

1. While on any of the three dashboards, click the New Request link in the left-side menu. 

 
Exhibit 1-1 Enter Request Received Offline 

2. Conditionally Required: Select a Sub-Agency to route the request. Upon submission, the request 
will display in this office’s Unassigned Cases dashboard. (Note: You can only enter requests 
within FOIAonline for your agency.) 

3. Enter the Submitted Date, which can be backdated as far back as necessary. 

4. Optional – Enter the Perfected Date, which can also be backdated. 

*Note: Once the Perfected Date is set, it cannot be unset. The processing clock will begin. This 
field cannot contain a date that is prior to the Submitted Date. 

5. Enter the requester’s full name, mailing address, and any additional fields provided. 

*Note: If an email address is provided by the requester and it is entered on this page, then the 
requester will receive a system email confirmation with their tracking number. If you would like 
to bypass this notification but still have their email address on file, then enter the email address 
via the Edit Requester Information page (2.1) after the request is submitted. 

 

1 
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Exhibit 1-2 Create Request Page: Agency Selection and Contact Information 

 

6. Enter the requester provided Fee Limit. 
7. Enter the requester provided Description of records. 

 
Exhibit 1-3 Create Request Page: Processing Fees and Description 
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8. Optional – If the requester has requested either a fee waiver and/or expedited processing, then 
switch the applicable drop-downs to Yes. This will display a free text field for you to enter the 
requester’s justification. You will also be required to select a date of the submission. 
 

*Note: Upon indicating either fee waiver or expedited processing, these will display in the 
dashboard as a task, which will have the same tracking number as the request. This allows either 
of these items to be separately evaluated and assigned from the request. Track the status of these 
tasks by viewing the Assigned Tasks tab (2.5). 
 

9. Optional – Upload any supporting documents provided by the requester, which can include an 
electronic copy of the original request. 

10. Press the Preview button to display the Preview page. 

 
Exhibit 1-4 Create Request Page: Request Fee Waiver, Request Expedited Processing,  

and Attach Supporting Files 
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11. Optional: Press the Edit Request button to return to the previous page and modify any 
information. 

12. Press the Submit button. 

 
Exhibit 1-5 Preview Request Page 

1.2 Frequent Requester Steps 
Have a frequent requester? Save time entering in their contact information by searching for a previously 
created request in FOIAonline and pulling up the Request Details page. 

1. Click the duplication icon next to the requester’s name on the Request Details page to pre-
populate the Create Request page with their contact information. 
*Note: You will be able to edit the requester’s contact information that is pre-populated on the 
Create Request form, unless the requester has a registered user account. 

2. Complete steps 6-12 listed above. 

 
Exhibit 1-6 Frequent Requesters - Duplication Icon 
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1.3 Request Creation Summary 
Agency users can enter FOIA request information for requesters who submit outside of FOIAonline. These 
requests are routed in the same manner as when they are submitted by the public – the request will display in 
the Unassigned Cases dashboard of the agency or sub-agency that is specified on the Create Request page. 
Entering an email address for the requester will send the individual an email confirmation upon submission. 
For requesters who frequently submit their requests offline, agency users can pre-populate the Create Request 
form with their contact information from a previous request by using the duplication icon. 
Upon submission, the tracking number will be publicly available. Depending on your agency’s configuration, 
the requester name, organization, description of records, and any supporting attachments may default to being 
withheld from the public. See section 2.2 Submission Details Tab for steps on how to flip the switch to make 
any or all of that information publicly available. The public will always be able to view the Tracking Number, 
phase diagram, and due date of any request in the system. 
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2 Navigating the Request Details Page 
2.1 Edit Requester Contact Information 
Contact information can be modified from the Request Details page for public users who do not have a 
registered account with FOIAonline. 

1. Verify the requester does not have an account by viewing the Requester Has Account 
field. 
*Note: Requesters with a registered account are responsible for updating their contact 
information. 

2. Click the show all details icon. 

3. Click the pencil icon. 

 
Exhibit 2-1 Edit Requester Contact Information 

4. Modify the requester’s contact information and/or Fee Limit, as necessary. 

5. Press the Save Changes button. 
2.2 Submission Details Tab 
The Submission Details tab contains all fields necessary for evaluation and is divided into three sections: 
Request Handling, Request Description, and Attached Supporting Files. In order to save modifications made on 
the Submission Details tab, press the Save Changes button at the bottom of the page (see section 2.2.3 
Attached Supporting Files). 
2.2.1 Request Handling 
The Request Handling section contains a variety of fields necessary for request evaluation, including: the toggle 
to make the requester name publicly available, the request track, the requester’s fee category, fee waiver and 
expedited processing tracking, and perfection. 

1. Requester Info Available to the Public controls whether the requester name and organization 
are visible to the general public when viewing the request. 

2. Request Track contains the values Simple and Complex. This field allows you to filter requests 
on the dashboard by the value selected and is used for reporting metrics. 
*Note: If expedited processing is granted, then Expedited will display here and it is no longer 
modifiable. Expedited requests display at the top of the dashboard. 
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3. Fee Category contains the values Commercial, Media/Educational, and Other. The selection 
made here deducts applicable discounts from the Admin Cost tab (9) for the invoice (18). 
Commercial requesters are charged for all search, review, and duplication. 
Media/Educational requesters are charged for duplication, excluding the cost of the first 100 
pages. 
Other requesters are are charged search and duplication, excluding the cost of the first 2 hours of 
search and the first 100 pages. 

4. Fee Waiver Requested tracks whether the requester submitted a fee waiver request at the time 
of submission. 
*Note: If “No,” then a pencil icon displays. Click the pencil icon to create a fee waiver task, if 
necessary. 

5. Fee Waiver Status tracks the disposition of the fee waiver task, if the fee waiver was requested. 
If it was not requested, then “N/A” displays. 

6. Expedited Processing Requested tracks whether the requester submitted an expedited 
processing request at the time of submission. 
*Note: If “No,” then a pencil icon displays. Click the pencil icon to create an expedited 
processing task, if necessary. 

7. Expedited Processing Status tracks the disposition of the expedited processing task, if one 
exists. If one does not exist, then “N/A” displays. 

8. Request Perfected field displays a drop-down for unperfected requests, which always defaults 
to No. Once the request is perfected, this field becomes read-only and the request cannot be 
unperfected. 

9. Perfected Date is the date the request was perfected. This can be backdated, if necessary, at the 
time of perfection. Once the Request Perfected field is set to Yes, this field cannot be modified. 

10. Acknowledgment Sent Date is an optional field to indicate when the acknowledgment letter, if 
applicable, was sent to the requester. 

11. Unusual Circumstances? is tied directly to the Extend the Due Date action item (8). When the 
due date is extended due to unusual circumstances, that is indicated on the main page of the 
request. 

12. 5 Day Notifications sends a system notification to the assigned individual every 5 days the 
request is pending. 

13. Litigation indicates if litigation has occurred. Select Yes from the drop-down to display the 
Court Docket Number field. A Court Docket Number is required when indicating litigation. 
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Exhibit 2-2 Submission Details - Request Handling 

2.2.2 Request Description 
The request description is always withheld from the public initially but making the description available to the 
public has the potential to reduce the number of future requests. 

1. Short Description is an optional free-text field that is only visible to the agency users. 
Text entered here displays when hovering over the tracking number while on the dashboard. 

2. The Description displays as read-only. 
*Note: Text entered in this field can never be changed. If the description needs to be modified, 
then see item #4, the Has Description Been Modified? checkbox. 

3. Description Available to the Public flag is set to No on default. Set this flag to Yes in order to 
make the description publicly searchable and viewable. 

4. Check the Has Request Been Modified? checkbox to display a free text field that automatically 
populates with the original request description, but can be modified as necessary. The original 
description will always be preserved. 
*Note: If the Description Available to the Public flag is set to Yes and the description has been 
modified, then the modified description displays to the public. 

 
Exhibit 2-3 Submission Details - Request Description 
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2.2.3 Attached Supporting Files 
The Attached Supporting Files section contains all attachments provided by the requester at the time of 
submission. These attachments can include additional justification for the request description, fee waiver and/or 
expedited processing, and/or an electronic copy of the original request. 
Any files uploaded here are available to requesters with registered user accounts, regardless of the value 
selected in the Attachments Available to the Public drop-down. 

1. Attachments Available to the Public drop-down controls whether or not the attached files will 
be viewable to the general public. This drop-down will default to No. 

2. The Remove icon displays a prompt, asking you if you would like to delete the selected file. 
3. The Select Files button in the Upload Supporting Files section allows you to select one or more 

files from your computer. Selected files display within the section and are only uploaded to the 
Attached Supporting Files section upon pressing the Save Changes button. 

4. Press the Save Changes button to save any modifications made on the Submission Details tab. 

 
Exhibit 2-4 Submission Details - Attached Supporting Files 
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2.3 Case File Tab 
The Case File tab contains a direct URL to the case, case specific information, and a series of sub-tabs that store 
responsive records, consultations, correspondence, appeals, invoices, and restricted materials (2.3.1-2.3.6). Case 
information displays as the following fields in the Case Details section: 

1. Type of Case displays that this is a FOIA case. 
2. Fiscal Year displays the fiscal year in which the request was submitted. 
3. Total Days Pending is the total number of days the request has been open. 
4. Final Disposition displays the final disposition that has been assigned to a case. 
5. Other Disposition displays an agency approved “Other” disposition that has been assigned to a 

case. 
*Note-Both the Final and Other Disposition fields only display once the close-out process has 
begun. 

6. Received Date is based on the business day the request was received. If the request was 
submitted to FOIAonline at 5:01pm EST on a Friday, then the Received Date would be the 
following Monday. 
*Note-This field is designated as the Business Date of Receipt for appeals. 

7. Clock Initially Started On is the date the clock began, either manually during perfection or if 
the 10-day clock auto-start began. 

8. Closed Date is the date the Final Disposition Notice was closed and the case completed. 
*Note-This field only displays once the close-out process has been completed. 

 
Exhibit 2-5 Case Details - Final Preparation of Response

2.3.1 Records Sub-Tab 
Case Responsive Records displays all records uploaded to the case file via the Upload Responsive Records 
action item. This includes all release types, which includes: redacted and unredacted, releasable and unreleasable, 
and releasable to the requester only (10). 
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2.3.2 Consultations Sub-Tab 
The Consultations sub-tab displays all pending and closed consultations created off of the request to system 
participating agencies. 

 
Exhibit 2-6 Case File - Consultation Sub-Tab 

2.3.3 Correspondence Sub-Tab 
The Correspondence sub-tab contains all correspondence sent to the requester via email and all files related to 
correspondence (14). 

2.3.4 Appeals Sub-Tab 
All appeals created off the request are linked via the Appeals sub-tab. If a request is appealed, then “Appealed” 
text will display next to the request’s status. Appeals have unique tracking numbers. 
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2.3.5 Financing Sub-Tab 
The Financing sub-tab contains information pertaining to any cost estimates sent to the requester, all invoices 
generated (18), and any payments received from the requester. 

 
Exhibit 2-7 Case File - Financing Sub-Tab 
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2.3.6 Restricted Materials Sub-Tab 
The Restricted Materials sub-tab can contain files that only individuals within your immediate office should be 
able to view. Individuals who exist organizationally outside your office, either above or below, cannot see any 
items that are uploaded to this section. 

1. Press the Restricted Materials tab to view and upload Restricted Materials. 
2. Press the Select Files button to select files to upload. 
3. Press the Save Changes button to add the files to the Restricted Materials section. 

 
Exhibit 2-8 Restricted Materials Sub-Tab 

2.4 Admin Cost Tab 
The Admin Cost tab displays all billable and non-billable time entered by users who performed processing work 
on the request (9). 

2.5 Assigned Tasks Tab 
The Assigned Tasks tab aggregates all system-generated and user-generated tasks created off the request (12). 

2.6 Comments Tab 
The Comments tab is an agency-user-only processing journal (15). 

2.7 Review Tab 
The Review tab is the staging area for the case file review workflow. See sections 16 Add Reviewer and 19.2 
Case File Review Steps for more information.
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3 Making Assignments 
A newly submitted request exists in the Unassigned Cases dashboard of the specified organization, which is a 
group box. In order to prevent multiple individuals simultaneously processing the same request, requests should 
be assigned out of the group box as quickly as possible. This can be accomplished through the Make 
Assignment page, which displays in the following areas in the system: 

1. Unassigned Cases dashboard, 
2. Click the Make Assignment action item from the left-side menu on the Request Details page, and 
3. The Make Assignment section displays at the bottom of the Custom Report Results. 

Options 1 and 3 allow you to assign multiple items (requests, tasks, appeals, consultations, and referrals) to a 
single individual or organization at the same time. 
The three assignment options are to yourself (3.1 Assign to Me), to another component (Assign to an 
Organization), or to an individual within your component (3.3 Assign to an Individual). If any tasks exist, then 
the tasks will not be assigned at the same time, but tasks can be assigned using the same processing steps. You 
cannot reassign any tasks currently assigned outside of your component. 
Comments can be added directly to requests via the Make Assignment page that will populate the request’s 
Comments tab (2.6). Comments added to tasks via the Make Assignment page will trickle up to the request. 

3.1 Assign to Me 
1. If you are on the Request Details Page: Click the Make Assignment action item from the left-

side menu 
If you are on either the Unassigned Cases Dashboard or Custom Report Results: select the 
items to assign by checking the Assign checkboxes in the left-most column. 

2. Press the Assign To Me button to assign the request to your user account. The request is now 
accessible via your My Cases dashboard. 

 
Exhibit 3-1 Assign to Me 
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3.2 Assign to an Organization 
1. If you are on the Request Details Page: Click the Make Assignment action item from the left-

side menu. 
If you are on either the Unassigned Cases Dashboard or Custom Report Results: select the 
items to assign by checking the Assign checkboxes in the left-most column. 

2. Click the person icon next to the Organization Assignment field to launch the Select 
Organization popup. 

 
Exhibit 3-2 Make Organization/Individual Assignment 

3. Enter text in either the Acronym or Name field.  
*Note: The user's acting agency acronym is automatically entered in the Acronym field and sub-
agencies display in the search results. This can be re-filtered by modifying the text. 

4. Press the Search button. 
5. Click the radio button for the desired organization in the first column. Only one organization 

can be selected at a time. 
*Note: Only 5 results display at one time. Use the pagination icons to flip through the results if 
more than 5 items exist. 

6. Press the Select button. 

2 
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Exhibit 3-3 Organization Lookup 

7. Optional - Enter a comment that will display in two places: 1. The assignment notification email 
and 2. The Comments tab (15 Creating Comments). 

8. Press the Save Changes button to send the item(s) to the Unassigned Cases dashboard of the 
chosen organization. 
*Note: The FOIA Officer will receive a system assignment notification if their Case File 
Modification Alerts item is enabled on the My Account page. 

 
Exhibit 3-4 Make Organization Assignment 
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3.3 Assign to an Individual 
1. If you are on the Request Details Page: Click the Make Assignment action item from the left-

side menu. 
If you are on either the Unassigned Cases Dashboard or Custom Report Results: select the 
items to assign by checking the Assign checkboxes in the left-most column. 

2. Click the Individual Assignment field or person icon to open the Select Individual lookup. 

 
Exhibit 3-5 Make Individual Assignment 

3. Enter information into any of the following three fields to search for an individual: Name, 
Organization Acronym, and/or Organization Name. 

4. Press the Search button. 
5. Click a radio button for an individual in the first column. Only one individual can be selected at 

a time. 

6. Press the Select button. 
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Exhibit 3-6 Individual Lookup 

7. Optional – If the selected individual has multiple actual agencies, then a popup will display with 
the Available Actual Agencies section. Click the radio button to the left of the desired agency 
and press the Select button. 

 

Exhibit 3-7 Available Actual Agencies 

8. Optional – Select the 5 Day Notifications checkbox to send email notifications to the assignee 
every 5 days. 
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9. Optional – Enter a comment, which will display in the assignment notification email and the 
Comments tab (15). 

10. Press the Save Changes button. 

 
Exhibit 3-8 Make Assignment to Individual 

 

11. Optional – Click the Click Here hyperlink in the message to return to the Request Detail page. 

 
Exhibit 3-9 Assignment Confirmation 

3.4 Summary 
Making assignments is important in ensuring an individual takes responsibility for a request. Assigning to the 
user's own account allows for quick ownership of a request for immediate processing. Assigning to other 
individuals or organizations allows for ownership by those deemed appropriate to fulfill the request. When an 
assignment has been made to an individual, the request displays in their My Cases dashboard as well as the 
Assigned Cases dashboard for the individual who assigned the request. When an assignment has been made to 
an organization, the request displays in the Unassigned Cases dashboard for users in that organization. While 
there must be one assignee to a request, multiple parties may contribute to the request processing through the 
Create Task (12) function. 
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4 Perfecting a Request 
A perfected request is one that is considered to reasonably describe the records sought and adheres to agency 
regulations related to request processing. While perfection is not a requirement to close-out a request, certain 
processing action items are only available to a perfected request. In most instances if a request is not yet 
perfected, then the text “(Never Started)” displays next to the number of days on the clock. Users should 
ensure that the perfected designation and perfected date are accurate before saving as a perfected request 
cannot be unperfected. 

4.1 Steps 
1. Select "Yes" from the Request Details page using the Request Perfected drop-down. 
2. Optional – Adjust the date of request perfection using the Perfected Date field. The Perfected 

Date field only displays when “Yes” is selected from the Request Perfected drop-down. The 
Perfected Date can be backdated as far back as the Submitted Date, if needed. If the perfected 
date is backdated, then the clock will start with a non zero number of days. 

 
Exhibit 4-1 Perfecting Request 

3. Press the Save Changes button at the bottom of the Submission Details page. 
4. The clock now displays with a number, counting up from 0, without the text “(Never Started).” 

 
Exhibit 4-2 Clock Has Started 
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*Note: Now that the request is perfected, the clock starts and additional action items are 
available, as shown below in Exhibit 4-3 Unperfected v. Perfected Action item Menu: Stop the 
Clock, Extend Due Date, Upload Responsive Records, Create Consultation, Create Referral, and 
Generate Invoice. The clock displays the number of days since the request was perfected, minus 
any stoppages that were created on the request (5). 

 
Exhibit 4-3 Unperfected v. Perfected Action item Menu 
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4.2 Summary 
Perfecting a request is required to unlock functionality necessary to process the request beyond simple close-
out. If insufficient information is provided, the request can be closed with the proper disposition, or more 
information can be asked of the requester through the Create Correspondence action item (14) without having to 
perfect the request. Once the request is perfected and the clock has started, the agency has 20 working days (30 
if there are unusual circumstances) to close-out the request before it is considered backlogged, indicated by a 
red flag icon displayed next to the clock. The due date may be extended, however, if certain conditions arise (8). 
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5 Estimating Costs 
Send a cost estimate to the requester at any point while the request is open. When a cost estimate is created, the 
system generates an Estimate Cost Notice task for the agency user to review prior to emailing the requester. The 
agency user has the option to mark the estimate for required payment during the close-out of the task. Cost 
estimates that are marked for required payment display to the requester and an agency user is given the ability 
to enter payments through the system. Once the task is closed, the status changes to Estimate Costs. The agency 
user may find this to be an appropriate time to stop the clock for fee-related reasons (see section 6 Stopping the 
Clock). 
5.1 Steps 

1. Click the Estimate Costs action item from the left-side menu of the Request Details page. 
2. Enter appropriate values for the estimate fields. 
3. Optional – Press the Total button to view the total estimate, which includes any applicable fee 

category discounts (see 2.2.1 Request Handling). 
4. Press the Save Changes button to generate the Estimate Costs Notice task. 

 
Exhibit 5-1 Estimate Costs 
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5. Optional – If the total estimate exceeds the requester’s fee limit, then a notification displays. 
Press the Yes button to proceed with generating the Estimate Cost Notice task. 

 
Exhibit 5-2 Fee Limit Notification 

6. Access the Estimate Costs Notice task from one of two locations: the My Cases dashboard of 
the request owner, or the request’s Assigned Tasks tab. 
*Note: If the request is not assigned to an individual, then the task is accessible from the 
Unassigned Cases dashboard of the office the request is assigned. 

 
Exhibit 5-3 Assigned Tasks Tab – Estimate Cost Notice Created 

7. Click the Close Out Task action item from the left-side menu of the Task Details page. 
8. Optional – Select a letter template and modify the text as necessary. This will generate a PDF 

letter that will automatically attach to the email. 
9. Modify the Email Subject and Email Body fields as necessary. 

*Note: The Email Body field automatically populates with the cost estimate provided on the 
Estimate Costs page but can be modified. 
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10. Select an option from the Mark Estimate as Required? drop-down. 
11. Either press the Send button to send an email to the requester OR, 
12. Press the Close Without Sending button to close the task without sending an email. 

*Note: This is used in scenarios where the requester does not have an email address on file. In 
this case, the agency user should notify the requester of the cost estimate offline. 

 
Exhibit 5-4 Estimate Cost Task Notice – Close-out  
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13. Upon closing the Estimate Cost task, the request’s Status changes to Estimate Costs. The cost 
estimate is also saved to two places within the case file: Correspondence (2.3.3) and Financing 
(2.3.5). 

 
Exhibit 5-5 Estimate Costs Status 

 

5.2 Summary 
Estimate costs for a request at any point during request processing. The cost estimate factors in any applicable 
requester fee category discounts. A separate task is created in order to view and edit the email sent to the 
requester prior to sending. Once the task is closed, the request’s status changes to Estimate Costs, and the 
correspondence is saved to the Case File – Correspondence page (2.3.3). The cost estimate is also tracked in the 
Case File – Financing page (2.3.5). 
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6 Stopping the Clock 
The clock on a request may be stopped for either clarification or fee-related reasons. Doing so will keep the 
clock at its current time until the issue is dealt with and the clock is restarted. A log of all stoppages displays on 
the Stop the Clock page. Requehsts that are on hold display a clock icon next to the tracking number when 
viewing from the dashboard, as shown below, and the Request Details page. 

 
Exhibit 6-1 Stopped Clock Icon 

Guidelines 

 The clock can be stopped for clarification once, but only within the first 20 days.  

 There are no limits on stopping the clock for fee-related reasons. 

6.1 Stop the Clock Steps 
1. Click the Stop The Clock action item from the left-side menu of the Request Details page. 
2. Select an option from the Reason drop-down. 
3. Enter an explanation into the Notes field. 

4. Press the Stop The Clock button. 

 
Exhibit 6-2 Stop the Clock 
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7 Starting the Clock 
After performing the Stop the Clock action (5), the action item in the left-side menu changes to 
Start the Clock. This page logs all clock stoppages that have been performed on the request. 
7.1 Start the Clock Steps 

1. Click the Start The Clock action item from the left-side menu of the Request Details page. 

 
Exhibit 7-1 Start the Clock Action item 

2. Press the Start the Clock button. 

 
Exhibit 7-2 Start the Clock Page 

7.2 Summary 
Once the clock is stopped, it remains at the current number of days until it is restarted. The action item to start 
the clock is found where the stop the clock action item was originally listed. Once restarted, 
the clock may again be stopped using the same method, however, clarification will not be 
available if it has already been used or if 20 days has elapsed. 
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8 Extend Due Date 
By default, the request due date is set 20 working days from the perfected date. If more time is needed, whether 
due to unusual circumstances or not, the due date can be extended to a new date determined by the user. If a 
Public Liaison, Professional, or SME performs the following steps to extend the due date, then the extension 
must be approved by the component’s management. The system automatically generates a task and assigns it to 
the component’s Unassigned Cases dashboard for National Team or Coordinators to approve or deny. 
8.1 Extend Due Date Steps 

1. Click the Extend Due Date action item from the left-side menu of the Request Details page. 
2. Select Yes or No from the Is Extension due to Unusual Circumstances? drop-down. 

*Note: If No is selected, Requester Extension Approval and Date Requester Extension 
Approval Granted required fields display. 

3. Optional – Change the Estimated Date of Completion if necessary. 
4. Enter an explanation into the Extension Justification field. 
5. Press the Extend Due Date button. 

 
Exhibit 8-1 Extend Due Date Page 

6. National Team or Coordinators at this point may need to complete the Extend Due Date Task, 
if one was generated. If no approval is necessary, then the Due Date will automatically update. 

 
Exhibit 8-2 Extend Due Date Task Generation Confirmation 
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7. Once the National Team or Coordinator accesses the task, either select Grant or Deny from the 
Decision drop-down. 

8. Press the Close Out Task button to complete the task. 
*Note: If granted, then the request’s Due Date will update accordingly. 

 
Exhibit 8-3 Extend Due Date – Close-out Task 

8.2 Summary 
If more time is required to process the request, extending the due date allows the date of completion to be set to 
a more reasonable date. However, this will not affect the 20 day clock that determines if the request is 
backlogged. Voluntary extension approval may be received through communication with the requester. This 
correspondence will be captured if communicated with a registered user through the system but can also be 
uploaded to the case file using “Other” Correspondence (13). Once an extension is performed, a task is created 
within the system for a FOIA Coordinator to approve. 

7 

8 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 31 

9 Adding Admin Costs 
Processing time entered on the Admin Cost tab populates the annual report and an invoice when it is generated. 
All costs incurred fulfilling requests should be recorded in this table, ranging from time spent searching for 
records to expenses associated to creating copies of records. The two types of costs are: billable, which are 
charged to the user, and non-billable, which are expenses for the agency but not present on the user invoice. 
Individuals who are tasked from the request (12) also have access to enter their processing time prior to closing 
the task. Time can also be entered for users who do not have a system account. The importance of capturing 
both billable and non-billable expenses results from the inclusion of these costs in the end of the year FOIA 
annual report. 
The system automatically deducts any applicable requester discounts based on the Fee Category selected on the 
Submission Details tab (2.2.1). The total billable cost minus any discounts will be applied to the invoice and 
reflected on the Admin cost page. 

9.1 Adding Billable Time Steps 
1. Click the Admin Cost tab while on the Request Details page. 
2. Press the Add New Entry button to display the New Entry form. 

 
Exhibit 9-1 Admin Cost Tab 

3. Select the appropriate User Type for the cost being entered. 
*Note: Your user populates automatically with an administratively-set billable rate. 

4. Optional – To enter time for another user with a system account, click the person icon to the 
right of the field and search for an individual in the popup. To enter time for another user who 
does not have a system account, select Non-System User from the User Type drop-down and 
enter their Loaded Rate and Billing Rate. 

5. Select the appropriate Charge Type for the cost being entered. 
6. Enter the appropriate expense information based on the Charge Type selected. This will either 

be an hourly or per quantity value. For hourly costs, time can be entered in 15 minute increments 
(15 minutes = 0.25). 

7. Use the Billable? drop-down to indicate if a charge is or is not billable to the requester. 
*Note: A required text field will display to explain non-billable costs. All non-billable costs will 
be charged as an agency cost to process FOIA requests. 

8. Press the Save Changes button. 

2 
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Exhibit 9-2 New Cost Entry   

9. The Total displays the running total of all the billable and non-billable charges entered.  
10. The Invoice Amount displays at the bottom of the Entries table. This is the total billable 

amount minus deductions based on the fee category (2.2.1) selected, and will display on the 
generated invoice (18). 
*Note: View the requester’s fee limit in the expandable/collapsable requester contact 
information section (2.1). 

11. Optional - Click the pencil icon to edit any existing entries. 

12. Optional - Click the remove icon to remove an entry from the list. 

 
Exhibit 9-3 Admin Cost Entries Table   

9.2 Summary 
The information entered under the Admin Cost tab is included on the invoice and, for charges designated 
billable, charged to the requester after close-out. All charges designated non-billable are calculated as expenses 
to the agency to process FOIA requests and are captured for the annual report. Any requester discounts will be 
automatically applied to the invoice generated by the system and are represented by the Invoice Amount on the 
Admin Cost tab. 
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10 Uploading Records 
Request owners and those tasked with Request Details tasks (12) can upload responsive records to the case file 
of a perfected request (4). Records must have a release type associated to them, so it is preferable to upload 
records of the same release type using the Upload Responsive Records page. However, the release type can be 
individually modified on each record after the records are uploaded. 
Files can be added to the case file in two ways: An electronic file can be uploaded, or a file can be referenced 
but not physically attached to the case file. Classified documents should never be uploaded, nor referenced, in 
FOIAonline. Sensitive documents should never be uploaded, but can be referenced using the Add Without File 
Upload functionality. 
In ideal circumstances, high agency network connectivity and low system load, the ability to upload responsive 
records will rarely exceed 100MB at one time. All file types, with the exception of executable (EXE) files, are 
accepted. 
Records marked with the release type of Unredacted – Unreleasable and Redacted – Unreleasable will never be 
available to the requester or to the general public. Records marked as Unredacted – Releasable and Redacted – 
Releasable will be available to both the requester and to the general public. Records marked as Release to 
Requester Only will only be available to the requester, if the requester has a registered user account and is 
logged in, and the general public will not be able to view these records. 
Appeals staff has full access to the associated request, so having a complete case file (redacted and unredacted 
versions of records) provides them the information they need to evaluate the appeal without having to contact 
the original processor. 

10.1 Uploading Responsive Records 
1. Click the Upload Responsive Records action item from the left-side menu of the Request 

Details or Task Details page. 
*Note: The request must be perfected in order to access this action item (see section 4 Perfecting 
a Request). 

Electronic Record 
2. Press the Select Files button to select a file to upload (from your computer). 
3. Select a file(s) from the popup that displays and press Open. 

*Note: Multiple files can be uploaded at the same time using the Ctrl or Shift key on your 
keyboard. 
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Exhibit 10-1 Select File for Upload  

Referenced Record 
4. If no file exists for the responsive record (i.e. the record exists only in hard copy or as media), or 

the record is a sensitive document, press the Add Without File Upload button. 
*Note: This functionality is also useful if the request will be denied in full and your agency has 
chosen not to upload records unless they will be released. 

 
Exhibit 10-2 Add Record Without Upload  

5. All selected files are added to the Upload Responsive Records table. 
*Note: Responsive records uploaded without a file are not hyperlinked on the Case File - 
Records sub-tab (as there is no associated record to display upon clicking). 
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6. Optional – Change the Record Title field if the record name differs from the file name, or if the 
record does not have a physical file attached. 

7. Optional – Press the remove icon to remove a record. 
8. Optional – Press the Cancel button to cancel the upload process. All records on the page will 

not be uploaded to the case file. 
9. Select a Release Type to be applied to the entire batch of records being uploaded. 

*Note: Responsive records will not be available to the general public upon uploading. The 
request must undergo either an interim release or final closeout in order for the appropriate 
records to be released. The Release Type can be individually modified after records are 
uploaded. 

Unredacted – Unreleasable: Will not be available to the general public.  
Unredacted – Releasable to the General Public: Will be available to the general 
public.  
Redacted – Unreleasable: Will not be available to the general public.  
Redacted – Releasable to the General Public: Will be available to the general 
public. 
Release to Requester Only: Will not be available to the general public; will be 
available to the registered requester, upon logging in. 

10. Optional – Enter keywords that can be used to filter responsive records in the agency user’s case 
file, and can also be used by the public (once the records are released) to search for records. 

11. Press the Save Changes button to upload the records to the Case File - Records sub-tab 
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Exhibit 10-3 Save Records  

12. Optional – Modify the drop-down in the Publish column to change the release type. 
*Note: Records are grouped by release type, in the following order: REQ, RR, UR, RU, and UU.  
Releasable records (REQ, RR, and UR) are highlighted. 

13. Press the Save Changes button. 
14. Optional – Edit the records details, including Title and keywords, and apply exemptions by 

clicking the pencil icon to display the Edit Responsive Record page (see Exhibit 11-2). 
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Exhibit 10-4 Verify Uploaded Records  

10.2 Summary 
Uploading records is the main focus in fulfilling a request. Once the records are uploaded, multiple actions can 
be taken, including creating referrals or consultations, adding exemptions, and performing interim releases. As 
task owners upload records via the task, records aggregate to the Case File – Records sub-tab so the complete 
list displays at all times. Task owners are only able to edit or remove records they upload; full edit access to 
records is restricted to the request owner (all records) or the record owner (only records he or she uploads). 
Records identified as “releasable” or “release directly to requester” are only released following either the 
interim release or final close-out processes. 
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11 Apply Exemptions 
After uploading a record (10.1), access it by viewing the Case File – Records sub-tab. From here, multiple 
actions can be performed on a record, including applying exemptions. 
11.1 Steps 

1. While on the Case File – Records sub-tab, click the pencil icon in the Action column to display 
the Edit Responsive Record page. 

2. Select the checkbox(es) of the exemption(s) you would like to apply. 
3. Conditionally Optional –Select a pre-existing statute (multiple can be selected using the Ctrl or 

Shift key) after selecting exemption 3.  
*Note: If no applicable statute exists, then contact your component administrator and request a 
new statute be added to the drop-down. 

4. Conditionally Optional –Select a pre-existing subtype (multiple can be selected using the Ctrl or 
Shift key) after selecting exemption 5. 
*Note: If no applicable subtype exists, then contact your component administrator and request a 
new subtype be added to the drop-down. 

5. Press the Save Record Changes button. 

 
Exhibit 11-1 Edit Record 

11.2 Summary 
Requests containing a record with an exemption cannot be assigned the Full Grant final disposition. Exemptions 
applied to records count towards reporting metrics. If the same exemption is applied to multiple records within 
the same request, that exemption is only counted once towards the annual report. 
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12 Creating Tasks 
There are several different types of tasks within the system, many of which are automatically generated 
by the system upon performing a specific action. Types of tasks include: 

 Fee Waiver – to adjudicate separate from the request 

 Expedited Processing – to adjudicate separate from the request 

 Estimate Costs Notice – to notify the requester of a fee estimate 

 Extend Due Date – to gain approval for an extension 

 Interim Release Initial/Final Review – to notify a reviewer that a request or referral is ready for an 
interim release (Initial Review tasks are generated for all but the final reviewer) 

 Interim Release Notice – to notify the requester of an interim release 

 Initial/Final Review – to notify a reviewer that a request or referral is ready for final close-out (Initial 
Review tasks are generated for all but the final reviewer 

 Final Disposition Notice – to notify the requester of a final disposition 

 Partial Determination Initial/Final Review – to notify a reviewer that an appeal is ready for a partial 
determination (Initial Review tasks are generated for all but the final reviewer) 

 Partial Determination Notice – to notify the requester of a partial determination 

 Request Detail – to collaborate with other individuals or organizations 
The only task type that is manually-generated is the Request Detail task. This is done via the Create Task 
action item in the request’s left-side menu. All tasks, once generated, can be tracked from within the 
Assigned Tasks tab on the Request Details page. The system does not allow you to begin the closeout 
process if there are any pending tasks, so use the Assigned Tasks tab to keep track of any outstanding items. 
Request Detail task assignments are used for agency users to collaborate with other users within the same 
agency. Creating tasks off a request breaks the request down into pieces that may be collaborated upon to 
facilitate processing. 
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12.1 Steps 
1. Click the Create Task action item from the left-side menu of the Request Details page. There are 

two assignment options that allow the user to assign to an office or to an individual. 
2. Press the Add Organization (steps 3-8) button or the Add Individual (steps 9-14) button to 

assign the task to an organization or individual, respectively. 

 
Exhibit 12-1 Task Assignment Page 
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3. Press the Add Organization button to open the Select Organization lookup. 
4. Enter information into the Acronym or Name field. 
5. Press the Search button. 
6. Click a radio button in the first column next to the desired result. Only one organization can be 

selected at a time. 
7. Press the Select button. 
8. To add another organization, repeats steps 3-7. 

 
Exhibit 12-2  Organization Lookup  
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9. Press the Add Individual button to open the Select Individual lookup. 
10. Enter information into any of the following three fields to search for an individual: Name, 

Organization Acronym, and/or Organization Name. 
11. Press the Search button. 
12. Click a radio button in the first column next to the desired result. Only one individual can be 

selected at a time. 
13. Press the Select button. 
14. Optional – If the selected individual has multiple actual agencies, then a popup will display with 

the Available Actual Agencies section. Click the radio button to the left of the desired agency 
and press the Select button. 

15. To add another individual, repeat steps 9-14. 

 
Exhibit 12-3 Individual Lookup 
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16. Optional-Make a selection in the Type of Task dropdown 
17. Enter a description of the task in the Task Description field. 
18. Enter a date in the Task Due Date. 
19. Select Yes or No from the Allow task recipient(s) to edit metadata drop-down. 

Selecting Yes from this drop-down grants the task recipient(s) access to edit the fields on the 
Submission Details tab of the Request Details page (e.g., Request Track, Fee Category, 
Information Publicly Available flags, etc.). 

20. Press the Create New Task button. 
*Note: All tasks have the same tracking number as their associated request. 

 
Exhibit 12-4 Create Task   

12.2 Summary 
Creating a task off a request allows for the request to be sent to other agency users for collaboration. The task 
can be sent to multiple organizations and multiple individuals. The list of all tasks that have been generated on a 
case displays under the Assigned Tasks tab and contains the status, who it is assigned to, and the task due date. 
Task recipients receive an email notification, alerting them of the new item that now exists in either their My 
Cases dashboard (individual assignment) or Unassigned Cases dashboard (the designated FOIA Officer of the 
organizationally assigned task receives this email). Tasks have the same tracking number as their associated 
request. 
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13 Closing Tasks 
If someone has assigned you a task, then you will receive a system email notification. Any task assigned to you 
is accessible via your My Cases dashboard. 
All tasks must be closed prior to beginning the request’s closeout process (19). Request Detail tasks (12.1) grant 
the ability for the task owner to view the entire case file, bill admin time (9), upload responsive records (10), 
comment on the case file (15), and even create additional Request Detail tasks (12), if additional collaboration 
is necessary. Some tasks can also be assigned or re-assigned (2) (e.g., assigning a Fee Waiver task out of the 
Unassigned Cases dashboard or assigning a Request Detail task that was assigned to your organization to an 
individual). 
Every task is closed by clicking the last action item in the left-side menu while on the Task Details page. This 
action item will say either “Edit or Close Out Task” if a comment can be saved on the Close Out Task page, or 
“Close Out Task” if there is no Save button on the Close Out Task page. The following steps outline the process 
to close-out a Request Detail task. 
13.1 Steps 

1. Click the tracking number of the task that exists in the dashboard to display the Task Details 
page. 
*Note: Since tasks have the same tracking number as their associated request, pay careful 
attention to the Type column in the dashboard. Hover over the tracking number to display the 
description of the task. Dashboards can be filtered to display only tasks at one time. Expanding 
out the Detail row displays the type of task the item is. See section 12 for a complete list of Task 
Types. 

 
Exhibit 13-1 Accessing a Task  

2. Optional – Upload responsive records to the case file (10). 
3. Optional – Add a comment to the case file (15). 
4. Optional – Create additional tasks if additional collaboration is necessary (12). 
5. Optional – Add time to the Admin Cost tab (9). 
6. Optional – Assign or re-assign the task (3). 
7. Click either the Close Out Task or Edit or Close Out Task action item from the left-side menu 

of the Task Details page. 
8. Select Records Uploaded, No Records Found or Other from the Outcome drop-down.  
9. Enter a comment in the Comments field. For instance, if the task description was to search for 

responsive records, then indicate the records uploaded, if any, or what locations/databases were 
searched, etc. 

 1 
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10. Press the Close-out Task button. 
*Note: The task is now closed and is removed from your dashboard. The request owner is 
notified upon task closure, and the appropriate outcome now displays in the Assigned Tasks tab 
of the request. 

 
Exhibit 13-2 Close-out a Request Detail Task  

13.2 Summary 
If someone has individually assigned a request to you, then you will receive a system notification alerting you 
of the assignment. Access the task from the My Cases dashboard and perform any necessary processing. View 
who assigned the task to you by viewing the Task Details. All tasks must be closed prior to beginning the 
closeout process, so be sure to close all tasks assigned to you to allow the request owner the ability to close the 
request.  
System-generated tasks related to a request you are processing will automatically be available in your My Cases 
dashboard (e.g., Interim Release Notice, Final Disposition Notice, etc.) 
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14 Creating Correspondence 
Any communication with the requester is accomplished through the Create Correspondence action item. This 
section captures both system initiated and offline correspondence. If the requester has a registered user account, 
then system correspondence, including replies, can take place entirely within the system. When the requester 
replies within FOIAonline, a mail icon, shown below, displays next to the tracking number on the dashboard. 
Once the unread correspondence is viewed in the Case File – Correspondence tab, the mail icon no longer 
displays. 

 
Exhibit 14-1 New Correspondence Icon 

Form letters can be edited and generated from this page, for both correspondence sent directly to the requester 
and for correspondence being uploaded to the case file. 

14.1 Correspondence Steps 
1. Click the Create Correspondence action item from the left-side menu of the Request Details 

page. 
2. Select Correspondence to Requester (steps 3-7) or Other (steps 8-11) from the 

Correspondence Type drop-down. 

Correspondence to Requester 
*Note: If the requester does not have an email address on file, then text will display, shown 
below, notifying you that the correspondence has no recipient, and therefore cannot be emailed. 
It will still be saved to the case file, however. If you have the requester’s email address and need 
to add it to the case file, do so by editing their contact information (2.1). 

 
Exhibit 14-2 Create Correspondence – No Email Address on File Warning 

3. Optional – Select a letter from the Letter Template drop-down. 
*Note: After selecting a letter template, the Email Body field is replaced with letter- specific text, 
and a new Letter field displays. See 14.2 Letters for more information. 

4. Enter appropriate text in the Email Subject field. 
5. Enter a message in the Email Body field. 

*Note: The Body field pre-populates with basic request information, including the date and time 
and the tracking number. 

6. Use the Insert drop-down to enter request-specific information, e.g., Tracking Number, request 
description, submitted date, etc. 

7. Optional – Press the Select Files to upload correspondence attachments from your computer to 
be sent along with the email to the requester. 

8. Press the Create button. 
*Note: The correspondence has been emailed to the requester if there is an email address on file. 
If the requester has a registered user account, then he or she will be able to reply directly from 
within the system to the correspondence. 
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Exhibit 14-3 Email the Requester  
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Other 
*Note: “Other” correspondence requires either at least one file to be uploaded to the 
Correspondence Attachments section, or that a letter be selected and saved. 

9. Optional – Select a letter from the Letter Template drop-down. 
*Note: After selecting a letter template, the Letter field displays. See 14.2 Letters for more 
information. 

10. Optional - Press the Select Files button and select a file from your hard drive to upload. The 
selected file displays in a table prior to being saved to the case file. 

11. Press the Create button. 

 
Exhibit 14-4 Create Offline Correspondence Page  
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12. View all correspondence sent from the requester, if the requester has a registered account, and to 
the requester from the Case File – Correspondence sub-tab. 
*Note: The Correspondence to Requester section includes automated correspondence, e.g., the 
confirmation email the requester receives upon request submission. 

13. Click the Detail icon to expand the body of the email. If any attachments were sent with the 
request, including a letter, then they also display. 

14. Optional - Click the remove icon to delete the correspondence from the case file. 
*Note: This does not recall the email from the requester’s email inbox. 

 
Exhibit 14-5 Case File – Correspondence Sub-Tab   

14.2 Letters 
Form letters that are added in the Administration Letters page (see the FOIAonline Administration Guide), are 
available to be selected from the Letter Template drop-down on the Create Correspondence page. Selecting a 
letter for “Correspondence to Requester” will send the PDF letter to the requester as an attachment to the email. 

1. Select a template from the Letter Template drop-down to display the Letter field. 
*Note: If this is “Correspondence to Requester,” then the Email Body field will be replaced with 
the letter body text. 

2. The Letter field pre-populates with the following: agency mailing address, requester name, 
organization, mailing address, today’s date, Dear [requester name], letter body, Sincerely, 
request owner, and the request owner’s actual agency. 
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Modify the text as necessary, including using the Insert drop-down to insert request-specific 
information. 
*Note: Once the correspondence is created, the Letter field is saved as a PDF, and is either 
attached to the email sent to the requester (“Correspondence to Requester”), or is saved to the 
Other Correspondence section (“Other”). View the PDF letter by expanding out the Detail 
column in the Correspondence to Requester section in the Case File – Correspondence sub-tab 
(see Exhibit 14-5 Case File – Correspondence Sub-Tab). 
 

 
Exhibit 14-6 Correspondence – Select a Letter Template    
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14.3 Summary 
Correspondence is captured through the Create Correspondence action item. Capture email and system 
correspondence via the Correspondence to Requester type. The correspondence message, optional formal letter, 
and optional attachments are saved in the case file and are emailed to the requester. If the requester does not 
have an email address assigned to their account, then the correspondence is added to the case file but no email is 
sent. Capture offline correspondence (e.g., telephone conversation) via the Other correspondence type. The 
letter and/or the attachment is included in offline correspondence, which is added to the case file. 
Correspondence is never available to the general public. Only “Correspondence to Requester” items are 
available to the requester, if they have a registered user account. “Other” correspondence is not available to the 
registered requester. 
Automatic correspondence is also saved to the case file, e.g. Submission Confirmation, Estimate Costs Notice, 
Interim Release Notice, and the Final Disposition Notice. 
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15 Creating Comments 
Comments on a case file are visible only by agency users who have access to the request. Create a comment 
through the Create Comment action item in the left-side menu. If any comments were entered at the time of 
assignment (3), they also display in this section. The number of comments that exist displays in the tab, as 
shown below. 

 
Exhibit 15-1 Number of Comments  

15.1 Steps 
1. Click the Create Comment action item from the left-side menu of the Request Details page. 
2. Enter text in the Comment field. 

3. Press the Save button. 

 
Exhibit 15-2 Create a Comment Page 
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4. Click the pencil icon to expand the Edit Comment field. 
*Note: You can only edit comments if you are either the request owner, or a user with a 
management role. System automated comments cannot be modified. 

5. The Comment field pre-populates with the text, but can be modified. 
6. Press the Save Changes button to save the modifications to the comment. 

 
Exhibit 15-3 Edit Comments 

15.2 Summary 
The comments are saved to the case file with a timestamp. Comments can be used for any number of reasons, 
including to indicate external actions that have taken place, e.g. phone calls placed to involved parties, or as a 
timeline for remaining actions required to close a request. Comments can be added via the Create Comment 
action item in the left-side menu or during the assignment process. 
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16 Add Reviewer 
A review of the case file by another individual prior to request closure may be required by your agency or 
office. Even if your office does not require a case file review, it is recommended that one be performed to 
ensure accuracy in the released materials. The request owner may add him or herself to the Assigned Reviewers 
section, but this will not allow you to bypass the minimum reviewer requirement. If your office has a minimum 
reviewer requirement, then that must be fulfilled by adding individual(s) other than yourself. See 19.2 Case File 
Review Steps for more information. 
16.1 Steps 

1. Press the Add Reviewer button from the Request Details-Review tab. 

 
Exhibit 16-1 Review Tab  

 
2. Enter information into any of the following three fields to search for an individual: Name, 

Organization Acronym, or Organization Name. 
*Note: Users may also choose to assign themselves to a review position by pressing the Assign 
To Me button, but at least one reviewer other than the user must be assigned to begin close-out 
when a review is required. 
There is no search restriction on individuals added to the Review tab. 

3. Press the Search button. 

 
Exhibit 16-2 New Reviewer  
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4. Click a radio button in the first column for the desired result. 
5. Press the Select button. 

 
Exhibit 16-3 Individual Lookup  

6. Optional – When multiple reviewers are assigned, click the Change Review Order icons to 
change the review order positions. 

7. Optional – Press the remove icon to remove a reviewer. 

 
Exhibit 16-4 Multiple Assigned Reviewers  

16.2 Summary 
Reviewers are not notified upon being added to the Review tab as the review chain is being established and no 
action is necessary at this point in time. Once the request close-out process is initiated and the review process 
begins, reviewers receive a notification as with any other task assignment. All assigned reviewers are 
responsible for approving the Case File Review Task when the close-out process is initiated in order to close the 
request. The request owner may be assigned as a reviewer, but at least one other user must review the case file 
if a review is required. 
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17 Interim Release 
An interim release allows for selected records to be released prior to the final disposition of the overall 
request. This can be useful for complex requests that generate several records and close-out of the request 
is dependent on a consultation that is taking longer than expected. See section 9 for how to upload 
responsive records. 

17.1 Steps 
1. Click the Interim Release action item from the left-side menu of the Request Details page. 
2. Optional – Select the Interim Release Notice letter from the Letter Template drop-down. Modify 

the pre-populated formal letter that will be saved to the Other Correspondence section of the 
case file and will be attached as a PDF file to the email sent to the requester upon closing out 
the Interim Release Notice Task. See section 14.2 for more information regarding letters. 

3. Verify the drop-downs in the Publish column. Records marked as UR and RR will be released to 
both the requester and the general public, and records marked as REQ will only be released to 
the requester, if the requester has a registered user account. 
*Note: Records with a grayed out drop-down have been released during a previous interim 
release and cannot be “released again.” 

4. Optional – Enter text in the Invoice Comments/Instructions field. 
*Note: This populates the invoice that is generated (18). 

5. Press the Save Changes button. 
*Note: Upon pressing the Save Changes button, the case file review chain (19.2) will initiate, if 
one is required for your agency. 
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Exhibit 17-1 Interim Release Page   
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6. Once the case file review chain is complete, or if one was not required, the system generates the 
Interim Release Notice task. Access this task by clicking the tracking number from the My 
Cases dashboard, shown below in Exhibit 17-2 Access the Interim Release Notice Task, or via 
the Assigned Tasks tab of the request. 
*Note: The request owner receives an email notification when the Interim Release Notice task is 
generated. 

 
Exhibit 17-2 Access the Interim Release Notice Task  

7. Click the Close Out Task action item item in the left-side menu to display the Close-out Task 
page. 

8. Optional - Modify the Subject field. 
9. Optional - Modify the Body field as necessary. This is the body of the email sent to the requester. 

*Note: Use the Insert drop-down to insert request-specific information. 
10. Optional – Press the Select Files button to attach a file from your computer to be sent with the 

email. 
11. Select an option from the Attach to Send required drop-down to either attach the invoice and 

send the invoice to the requester, or to not attach the invoice to the correspondence and indicate 
the payment is not required.   

12. Optional – Press the Select button for items within the Attach Records or Past Correspondence 

section. This section can be filtered to display only correspondence items, or records marked as 
releasable or release to requester only. 
*Note: Items selected here move to the Selected Items to Be Sent to Requester section. 

13. Press the Send button. 
14. Enter your user account password in the popup and press the OK button. If your agency is 

CAC/PIV-enabled, then you will bypass this step. 

 6 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 59 

 
Exhibit 17-3 Interim Release – Close-out   
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17.2 Summary 
An interim release follows the same series of processes as request closure. If your office has a minimum 
reviewer requirement, then creating the interim release notice sends a task assignment to the first reviewer 
indicated under the Review tab (19.2). Once the review chain is complete, the system generates an Interim 
Release Notice task, which is assigned to the request owner. Once the request owner completes the task, the 
designated records are released and an email notification is sent to the requester. The Interim Release Notice 
email is stored within the Case File – Correspondence tab (14). 
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18 Generating an Invoice 
The request’s invoice is generated using information captured on the Admin Cost tab, and excludes both non-
billable costs and requester-eligible discounts. The invoice is automatically generated by the system and saved 
to the Case File – Financing sub-tab when either an interim release or the final close-out process have begun. 
The request owner can preview the invoice at any time while the request is open in order to view the total cost 
being billed to the requester (total billable charges minus any eligible discounts). Manually generating the 
invoice also saves it to the Case File – Financing sub-tab. 
18.1 Steps 

1. Click the Generate Invoice action item from the left-side menu of the Request Details page. 
*Note: Depending on your browser, you may need to press an Open or OK button in a popup 
that displays. 
Note: The Comments/Instructions text can be populated when completing the first step of 
either the interim release (17) or the final close-out process (19.1). 

2. Only billable charges display in the Description of Costs section. 

 
Exhibit 18-1 Invoice 
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3. View the invoice again via the Case File – Financing tab. 
4. View the Total Amount Billed Which Has Been Sent To Requester within the invoice section. 

This value is represented by the most recent invoice amount sent.  
5. Optional - Select an option from the Sent drop-down menu to either mark the invoice as sent to 

the requester or as not sent. Press the Save Invoice Changes button to save any modifications. 
6. Optional - Click the remove icon to delete the invoice from the case file. 

 
Exhibit 18-2 Case File Financing Tab - Invoice 

18.2 Summary 
The invoice offers a snapshot of the billable cost information as well as all important request details. This is 
automatically saved to the Case File – Financing sub-tab when manually generated via the action item menu 
and when initiating the interim release and/or final close-out processes. Invoices can be deleted from the case 
file as desired. 
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19 Close a Request 
There are two criteria every request must meet prior to beginning the close-out process: 1. The request must be 
assigned to an individual (3) and 2. Any tasks that exist in the Assigned Tasks tab must be closed (12). 
Additionally, if your office has a minimum reviewer requirement, then the proper number of reviewers, not 
including yourself, must be added to the Review tab (16). If your office does not have a reviewer requirement, 
then it is still encouraged to add an individual to the Review tab to provide a final chance to review the case file 
prior to releasing information to the public.  
The Closeout process is a multi-step process, either 2 or 3 mandatory steps depending on your component’s 
“minimum reviewer” requirement. Step 1 is to assign a disposition (19.1), step 2 is to complete the case file 
review (19.2), and step 3 is to complete the Final Disposition Notice task (19.3). 

19.1 Assign a Disposition Steps 
1. Click the Begin Close Out action item from the left-side menu of the Request Details page. 
2. Select a disposition from the Disposition drop-down. 

*Note: If no applicable disposition exists in the standard list of dispositions, then select Other 
from the drop-down to view the Other Disposition drop-down. If still no applicable disposition 
exists, then contact your component administrator and request a new “Other” disposition be 
added to the drop-down. 

3. Optional – select the Final Disposition Notice letter from the Letter Template drop-down to 
display the editable Letter field. This is pre-populated with request and agency-specific 
information, and the disposition dynamically updates based on the selection made in the 
previous field. 

4. If records are uploaded, verify the drop-down in the Publish column to ensure the correct records 
are being released, if applicable. 

5. Optional: Enter text in the Comments/Instructions field, which will populate the system 
generated invoice (18). 

6. Press the Begin Close-out button. 
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Exhibit 19-1 Final Disposition Page  

 

2 
3 

4 

5 

6 



  
 

FOIAonline Agency User Guide                                                                                                                                                                           June 3, 2016 
 65 

7. Click the Yes button in the popup. 

 
Exhibit 19-2 Begin Close-out Process  

Note: The status changes to Final Preparation of Response and depending on your role, the 
left-side action menu may significantly decrease. Once the close-out process has begun, no 
processing is permitted. Step 1 of the close-out process is complete and the system automatically 
initiates step 2, the Case File Review, if applicable. 

19.2 Case File Review Steps 
Upon completing the first step of the close-out process, the system generates an Initial Review task for the first 
reviewer, if applicable. This reviewer receives both a system email notification and a task in their My Cases 
dashboard. The request owner can track the progress by viewing the Review tab or the Assigned Tasks tab, as 
the status of the review is contained in both locations. This task grants the reviewer a read-only view of the 
entire case file. After the reviewer inspects the final disposition that was assigned, any responsive records, and 
any other metadata within the request, the reviewer can choose to either Approve or Deny the review task. 
Denying the review task lifts the processing restrictions that were implemented upon beginning the close-out 
process. The request owner can view comments provided with the case file rejection via the Assigned Tasks tab, 
make the necessary modifications, and initiate the close-out process again. Initial Review tasks will be sent to 
each reviewer in succession until all reviewers have approved their task, and conclude with the last reviewer 
who is assigned the Final Review task. 
The role of the user assigned to review a case file before close-out is to navigate the case file and examine the 
metadata and records for release. If the reviewer approves of the disposition set by the processor, they can close-
out the task for it to be sent to the next reviewer or back to the processor for final close-out. 

1. Click the Tracking Number link for the Case File Review task. The Case File Review task can 
be identified by expanding the Details column or by hovering over the Tracking Number link. 

 
Exhibit 19-3 Expanded Task Details 
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2. Review the request to ensure an appropriate disposition, charges, record release type, etc. have 
been applied to the case file (see section 2 Navigating the Request Details Page). 

3. Click the Edit or Close Out Task link in the left-side menu. 

 
Exhibit 19-3 Review Task Details  
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4.   Optional – Enter text in the Comments field. 
5.   If you wish to save any text entered in the Comments field and return to the task to complete at a 

later time, press the Save button. 
6.   Press the Approve button if you wish to approve the task as it is and initiate the next step in the 

close-out process, either sending the next reviewer a case file review task or sending the Final 
Disposition Notice Task to the request owner. 

7.  Press the Reject button if you wish to halt the review process and require the request owner to 
make any modifications. Even minor corrections necessitate a user press the Reject button. 
*Note: A Review task that is rejected requires input to the Comments field explaining the rejection. 

 
Exhibit 19-4 Case File Review Comments 

19.2.1 Summary 
Approving an Initial Review sends the task to the next reviewer until the last reviewer, who receives the Final 
Review task. Approval of this task generates the Final Disposition Notice task for the request owner. This 
moves the request to its final processing step before officially closing the request. If information in the case file 
is deemed not ready for approval, it is rejected and the request owner is notified to modify the case file as 
appropriate. The request owner can always track the progress of the case file review by viewing the Review tab 
and the Assigned Tasks tab of the request. 

19.3 Final Disposition Notice Task Steps 
This is the final step in the request close-out process. When the case file review chain is completed, the system 
generates the Final Disposition Notice task and sends the request owner an email notification. When the Final 
Disposition Notice task is closed, all records marked for release and information included in the notice will be 
sent to the original requester's email address. The request will be removed from your dashboard as no closed 
items exist in the dashboards. Re-access the request by either searching or using the Custom Report. 
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1. Click the Tracking Number link for the Final Disposition Notice task. The Final Disposition 
Notice task can be identified by expanding the Details column or hovering over the Tracking 
Number link. 

 
Exhibit 19-5 Final Disposition Notice Task  

2. Click the Close Out Task action item in the left-side menu. 

3. Optional: Depending on your role (Public Liaison, Coordinator, or National Team) you will be 
able to backdate the request’s closure date and close the task without sending an email. This 
ability will display in a section called Offline Closure Date. Select a date and press the Close 

Without Sending button. 
4. Optional – Make changes to the Subject field as necessary. 
5. Optional – Make changes to the Body field as necessary. 
6. Optional – Upload supporting files to be attached to the email using the Select File button as 

necessary. 
7. Select an option from the Attach to Send? required drop-down to either attach and send the 

invoice to the requester or to not attach the invoice, indicating the payment is not required. 
8. Optional – Press the Select button for items within the Attach Records or Past Correspondence 

section. This section can be filtered to display only correspondence items or records marked as 
releasable or release to requester only. 
*Note: Items selected here move to the Selected Items to Be Sent to Requester section. 

9. Press the Send button. 
10. Enter your user account password in the popup and press the OK button.  

*Note: If your agency is CAC/PIV-enabled, then you will bypass this step. 

1 
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Exhibit 19-6 Complete the Final Disposition Notice Task  

19.4 Summary 
With the verification of the confirmation message, the request is closed out. If the request includes the 
requester’s email address, then they will receive an email indicating the final disposition of their request and 
any records that were released with it. The request is removed from your dashboard but it may be viewed again 
by either using the Search function or the Custom Report (20-21). 
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20 Using the Search Function 
The Search function can be used to find all case files types in a variety of statuses both in your own agency and 
outside of your heirarchy. The Search function indexes all items within FOIAonline with full-text capabilities, 
so there is a two hour delay with its results. This means that a request recently created in the system may not 
display in the search results, or a recent status change may not reflect correctly on the results page. This does 
not mean that the status is incorrect. Also, due to the full-text indexing, the Search function can be used to find 
records based on the infromation contained therein. 

Search Tips:  

 Use Boolean search commands to find a more narrowed set of results, e.g. Superfund AND 
wilson. 

 Use wildcards to find a more generalized set of results, e.g. Ex. EPA-2015* 

20.1 Steps 
1. Use either the quick search (to the right of the main set of page tabs) or click the Search tab to 

display the Search page and use the Search For field. 
2. Optional: The Agency field defaults to search for items contained within your level/office of the 

agency and below. Expand your search results by selecting the Other Agencies radio button to 
search for items that exist outside of your immediate agency hierarchy. 

3. Press the Search button. 

 
Exhibit 20-1 Search Criteria 
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4. Click the Detail icon to expand more information. The criteria contained within the item that 
matches the Search For field is highlighted. 

5. Records are full text searchable. Click the paper clip icon to open or save the record file. 

 
Exhibit 20-2 Search Results  

20.2 Summary 
The Search function can be used to quickly find specific items within FOIAonline. Indexing case files and 
records with full-text capabilities allows users to search for information contained within such items. If more 
stringent search criteria is required to find the desired items, then use the Custom Report (21). 
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21 Custom Report 
In addition to the Search function, the Custom Report, which returns results in real-time, can also be used to 
find items within FOIAonline. The Custom Report has a wide variety of search criteria, which allows you to 
perform searches from the general to the highly specific. Refer to section 21.1 21.3 for specific use cases. 

 
Exhibit 21-1 Custom Report 
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21.1 Finding Closed Items 
1. Click the Custom Report link from the left-side menu while on the Reports tab. 
2. Enter a Closed Date range. 
3. Optional: Use the Type criteria to designate the type of case file. 
4. Press the Search button. 

  

Exhibit 21-2 Custom Report Results-Closed Items 
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21.2 Finding Items by Disposition 
1. Click the Custom Report link from the left-side menu while on the Reports tab. 
2. Make (a) selection(s) from either the Request Disposition or Appeal Disposition multi-selects. 

*Note- If a selection is made from the Request Disposition multiselect, then the Request and 
Referral checkboxes in the Type criteria are automoatically checked while the Appeal and 
Consultation checkboxes become read-only. If a selection is made from the Appeal 
Disposition multiselect, then the Appeal checkbox is automoatically checked while the 
Request, Referral, and Consultation checkboxes become read-only. 

3. Optional: Check the Task checkbox in the Type criteria to find tasks also associated to the 
selected disposition. 

4. Optional: Make a selection in the Open? dropdown to search for items that are open or closed 
at the time of the search. 

5. Press the Search button. 

 
Exhibit 21-3 Custom Report Results-Items Associated to a Specific Appeal Disposition 
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21.3 Finding Items Assigned to an Individual 
1. Click the Custom Report link from the left-side menu while on the Reports tab. 
2. Click the person icon to the right of the Assigned to Individual field to launch the Select 

Individual popup. 
3. Enter infromation into any of the three search fields: Name, Organization Acronym and/or 

Organization Name. 
4. Use the radio button to the left of the Full Name column to select the desired user. 
5. Press the Select button. 
6. Press the Search button. 

 
Exhibit 21-4 Custom Report Results-Items Assigned to an Individual 

21.4 Custom Report Export 
The Custom Report results can be exported to a spreadsheet using the CSV or Excel links at the bottom of the 
page. In addition to the fields displayed in the Custom Report table, the export contains the below fields, which 
can be useful for comparing and analyzing data. 

 Requester Organization – organization the requester is affiliated with if applicable 

 Case File Assigned To – individual or office the underlying case file is assigned to when line 
item is a task 

 Perfected? – whether or not a request has been perfected or an appeal has been marked as received 

 Closed Date – date a case file or task completes the close out process 

 Disposition – request and appeal dispositions that have been set prior and after case file closure 

 Additional Information Fields – agency specific fields found in the configurable Additional 
Information section 
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22 My Account 
Agency users can update their contact information, email notification preferences, and change their password 
from the My Account page. 
22.1 Edit Account 
The Edit Account page contains two sections: User Information and Email Preferences. The User Information 
section contains contact information and the email address used for logging in. 
*Note: If your agency is CAC/PIV-enabled, then you will not be able to edit your email address, since the email 
address is linked to the CAC/PIV card. 
The Email Preferences section contains three groups of email notifications. If the toggle is checked, then email 
notifications are active. If the toggle is not checked, then email notifications are inactive. New system users 
default to receiving all notifications. The following notifications are exempt from opt-out: appeal creation, 
requester request modification, withdrawn requests, exported requests, 5 day notifications, and emails regarding 
account notification. 

1. Modify the User Information fields as necessary. 

2. The Clock Auto-Start toggle controls the email notification that is sent when an unperfected 
request’s clock automatically starts after the 10th day of it remaining unassigned. 

3. The Case File Modification Alerts toggle controls the following email notifications: individual 
assignment, organizational assignment (if you are the organization’s designated FOIA Officer), 
items re-assigned from your queue, stopping and starting the clock, and due date extensions. 

4. The Case File Items Completed Alerts toggle controls the following email notifications: 
request detail and review task completions. 

5. Press the Save Changes button to apply changes. 

 
Exhibit 22-1 Edit Account Page  
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22.2 Change Password 
Passwords expire every 60 days. After a password has expired, the user is prompted to change their password 
upon logging in, but the password can also be updated at any time from the My Account tab. You cannot use 
any of your previous 24 passwords. 

1. Modify the User Information fields as necessary. 

2. The Clock Auto-Start toggle controls the email notification that is sent when an unperfected 
request’s clock automatically starts after the 10th day of it remaining unassigned. 

3. The Case File Modification Alerts toggle controls the following email notifications: individual 
assignment, organizational assignment (if you are the organization’s designated FOIA Officer), 
items re-assigned from your queue, stopping and starting the clock, and due date extensions. 

4. The Case File Items Completed Alerts toggle controls the following email notifications: 
request detail and review task completions. 

 
Exhibit 22-2 Change Password 
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